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Text Module

The Text module allows you to enter and modify text within text frames. You can also apply 
text rulers which determine how text will be formatted within text frames. The Text module 
contains six command groups which are described in this chapter. 

Working in the Text Module  
Text Mode  
Ruler Mode  

Control Codes Command Group 
Tools Command Group  
Dictionary Command Group  
Character Set Command Group  
Text Ruler Command Group  
Text Macro Command Group 



Working in the Text Module 
The Text module has two basic modes: Text mode and Ruler mode. Text mode is used to 
enter, move or delete text in a text frame in the document window. It is possible to insert 
control codes, such as page numbering, into text frames. You may also mark, modify, move, 
copy or delete text blocks in Text mode. 

Ruler is short for Text Ruler. In Ruler mode, you can insert and modify text rulers. Text rulers 
control the formatting of text in a text frame. Elements of a text ruler include left and right 
margins, paragraph indents, tabs, line spacing, paragraph spacing and text justification. 

In the Text module, the pointer has three possible shapes: if it is not over a selected text 
frame, it appears as a pointing finger. When placed over a selected frame, the pointer 
becomes a text cursor (Ibeam) in Text mode; in Ruler mode, the pointer appears as a cross 
hair. 

As long as the pointer is above a selected frame, you may switch between Text and Ruler 
modes by clicking the right mouse button. You can also change the frame size in Text or 
Ruler mode by moving the cursor to a frame handle. The cursor will change to the finger 
pointer. When you click a frame handle, the finger pointer will change to a cross hair as you 
drag the frame handle and resize the frame. When you move the cross hair over the text 
frame, it will return to its previous shape. 



Text Mode 
There are a number of basic functions in Text mode. You can:    

- Enter text directly into a frame. 
- Change or delete existing text in a text frame. 
- Mark text as a block for one of the block functions. 

To enter Text mode, click the Text module icon in the Module Row. When you select a frame 
or move the pointer over an active text frame, the pointer will change to a text (Ibeam) 
cursor. If the pointer appears as a cross hair instead of an Ibeam, you are in Ruler mode. 
Click the right mouse button to change to Text mode. 

Set the text cursor anywhere in the text frame by clicking the left mouse button once at the 
desired location. If there is no text where you clicked, the cursor will appear after the last 
character in the frame. If the text frame is empty, the cursor will appear in the top left 
corner of the frame. 

The text cursor shows where the next character will be inserted. To move up, down, left or 
right, use the cursor keys or click in the text frame. To move one word at a time, press 
[Control] and use the left or right cursor key. To move to the top or bottom of the text frame, 
press the [Page Up] or [Page Down] key. 

You can enter text by using the keyboard, as in any text editor or wordprocessor, or by 
importing it. Calamus will handle carriage returns automatically. If a word is too long to fit on
a line, Calamus will send the entire word to the next line. The [Backspace] key will delete the
last character entered, and it can backspace over line ends. You may also delete control 
codes using the [Backspace] key, but in this case more than one character may be deleted. 
To end a paragraph, use the [Enter] key. Special key functions can be created by using the 
commands in the Key Bindings Editor described in the Tools command group of this section. 

When text is entered in a text frame, Calamus will reformat the frame, or, in the case of a 
piping chain, subsequent text frames. Reformatting will occur instantly unless you set a 
keyboard delay in the Key Bindings Editor. This delay allows you to enter text relatively 
quickly, without waiting for the frame to be refresh after each character. When entering or 
editing a large amount of text, the text editor is more efficient. See the Text Editor section of
this chapter for more information. 

In the Text module, you can also mark blocks of text in the current text frame. There are a 
number of functions that can be applied to a marked text block. These are described in the 
Text Macro section of this section. 

To mark text, keep the left button pressed as you run the cursor over the desired text. This 
works left to right or right to left; you can move up or down the text. Marked text will be 
displayed in inverse video, as indicated here:    

To mark one word, doubleclick it; to mark a line of text, tripleclick; to mark a paragraph use 
four quick mouse clicks; to mark the entire text chain, click the mouse five times. Text can 
also be marked from the keyboard by pressing [Shift] and moving the up or down cursor key 



to mark a line; or [Shift][Control] and the left or right cursor key to mark one word at a time.

You can move marked text within a text frame or to another text frame by using drag and 
drop. Click on marked text and the drag and drop pointer will appear below the Ibeam cursor
as shown at left. Keep the left button pressed, move the cursor to another location and 
release the button. The marked text will be moved. To copy marked text, press [Control] 
before clicking the marked text. See Drag and Drop in Menus, chapter 2.

Marked text may be cut or copied to the Calamus clipboard or the Windows clipboard. Mark 
text and click the Cut or Copy icons in the Clipboard module; or click Cut or Copy in the Edit 
pulldown menu. The marked text will be cut or copied to the respective clipboard. To paste 
text from either clipboard, click the Ibeam cursor once at the desired location and click the 
Paste icon in the Clipboard module, or the Paste item in the Edit pulldown menu. 

When pasting text from the Edit pulldown menu, two dialog boxes appear. The first is Send 
Editor Text into Frame. Normally you will choose to Merge text at the cursor position. Be 
careful not to use Replace unless you want to remove existing text and replace it with the 
pasted text.



The second dialog box is Name Conflict. This dialog box appears when pasting text back into
the original document and the pasted text has the same color and text style names as those
in the text frame. Select Replace for all objects (color, style name, etc.). 

To delete marked text, click the trashcan icon or press the [Delete] key. You will be prompted
to confirm the deletion unless Warnings and Alerts are deselected in the Miscellaneous 
Settings dialog box in the Options menu.

To unmark text, press the [Esc] key, click the right mouse button, or click the left mouse 
button outside the marked text.



Ruler Mode 
When you change from Text mode to Ruler mode by clicking the right mouse button, all text 
rulers on the current page will be displayed.

You can select any one of the rulers by clicking it with the left mouse button. A selected text 
ruler will appear with a dark upper border. 

To change settings in a text ruler, drag the margin and tab icons or press [Shift] and click the
text ruler to call the Ruler Settings dialog box. Text ruler functions are described in the Text 
Ruler and Text Macro command groups, later in this chapter.



Control Codes Command Group
Functions: 

 Insert Current Page Number
 Insert Following Page Number 
 Insert Chapter Number 
 Insert Time 
 Insert Date 
 Insert Reference to Previous Page 
 Insert Reference to Next Page 
 Footnote Entry 
 Index Entry 
 Insert Manual Kerning 
 Insert Comment 
 Insert Text Style 
 Force Piping to Next Frame 
 Delete Text Block/Ruler 

The Control Codes Command Group contains three types of text function: control codes 
(date, time, etc.); reference codes (index, footnote, reference markers); layout codes (text 
style, manual kerning, text block). Control codes can also be installed in the text editor 
window as described in the Text Editor chapter. 



Insert Current Page Number 

This function inserts a control code at the current cursor position. After you have selected a 
number style as selected under Page Numbering in the Page module, this code will appear 
as the current page number.



Insert Following Page Number 

This control code will display the page number of the following page in the format selected 
under Page Numbering in the Page module. 



Insert Chapter Number

When you click this icon, a dialog box will appear. 

You may enter the number level of the current chapter in this box. The chapter number will 
appear at the cursor position. The chapter number is increased each time it appears, so it is 
not possible to enter the same chapter number twice.

This example shows how chapter numbering works: 

1 Level 1 

1.1 Level 2 

1.1.1 Level 3 

1.1.1.1 Level 4 

You can set the first chapter number and type of numbering with the Chapter Numbering 
command described in the Page module. Chapter numbers are updated by using Reformat 
Document in the Options menu.



Insert Time 

This control code displays the time the code was entered. This time is taken from your 
computer's internal clock, and can be updated by the Reformat Document function in the 
Options menu. Time may be displayed in a number of formats as selected in the System 
Parameters module discussed earlier in this chapter. 



Insert Date 

As with the Insert Time function discussed immediately above, this function inserts the 
current date using the computer's internal clock. The date is updated when you use the 
Reformat Document function in the Options menu. The date may be displayed in a number 
of formats as selected in the System Parameters module discussed earlier in this chapter.



Insert Reference to Previous Page 

This command will insert the page number of the previous frame in the current piping chain. 
If you are laying out a magazine and one of the articles is broken by a fullpage 
advertisement, this function will allow you to put, for example, Continued from page xx at 
the top of the next page. 



Insert Reference to Next Page 

This command is the complement of the preceding one. You may use it at the bottom of a 
page or column to enter, for example, Continued on page xx. 



Footnote Entry

This command will copy or transfer marked text from a text frame to a linked footnote 
frame. In the text, a number or letter will appear immediately after, or in place of, the 
marked text. To make footnotes visible, you must use the Reformat Document function in the
Options menu. 

Some examples will help make this and the corresponding functions clear. A typical 
situation: on one page there is a text frame containing text to be moved to a corresponding 
footnote frame. First, you must create the footnote frame. In the Text Special Functions 
command group, click the Footnote Frame icon. Now draw a footnote frame; it will contain a 
footnote frame icon. Select the first text frame in the piping chain and click the Piping from 
Frame to Frame icon. Then, click the footnote frame to connect it to the text frame.

Select the text frame again; switch to the Text module and use the text cursor to mark the 
text which is to appear as a footnote. Each time you click the Footnote Entry icon, an alert 
box will ask you to Copy or Paste the marked text into the footnote frame. If you select Copy,
the marked text will be copied to the footnote frame and a footnote marker will be appended
to the marked text. If you select Paste, the marked text will be cut from the text frame and 
replaced by a footnote marker in number or letter form; the marked text will be pasted into 
the footnote frame. (The text itself will not appear in the footnote frame until you use the 
Reformat Document function in the Options menu.)    Frame Entries should remain at Single. 
The dialog box which appears does, however, allow you to select which character in the 
footnote will act as a placeholder for the footnote number. 

Any page on which you want to place a footnote entry requires a footnote frame. Footnote 
frames must be piped to each other, not to the original text frame. Only the first footnote 
frame in a footnote piping chain should be linked to a text frame. For example, a footnote 
frame on page 3 should be piped, not to the text frame on the same page, but to the 
footnote frame on page 2.

Only pages that have footnotes should contain footnote frames. If footnotes were defined on
pages 1 and 3 only, but page 2 also had a footnote frame, the first footnote would appear 
correctly on page 1, but the second would appear on page 2 rather than on page 3 because 
Calamus placed the footnote entry in the next available footnote frame. If this occurs, or if 
you have more than one footnote in the same frame, you can insert a Force Piping to Next 
Frame code to move the footnote text to the next footnote frame. 

The second example is simpler. Instead of footnotes, create a series of endnotes in several 
footnote frames at the end of a document. Add several pages to the end of your document 
and pipe a series of footnote frames. Link the footnote piping chain to the text piping chain. 
To do this, select the first text frame; click Piping from Frame to Frame, then click the first 
footnote frame. Once you have marked all footnotes, use the Reformat Document function in
the Options menu to make the endnotes appear in the footnote frames. Since endnotes 
appear directly under each other, the Frame Entries field should be set to Unlimited. 

If you wish to change footnote numbers to Superscript, make sure that you have used the 
Reformat Document function first. If you do not, Superscript will automatically be applied to 
the footnote text, not just the footnote symbols. 

With regard to the Copy and Paste options: Copy is used to send a copy of the marked word 
or phrase to the footnote frame; Paste will remove the marked text from the frame and place



it in the footnote frame. The Paste function might be used, for example, when you have 
imported a text file that contains footnotes. Footnotes may be edited in the footnote editor 
window. 



Index Entry 

This function is used for creating index entries and corresponding page numbers. First, 
merge all files in your document into a piping chain. Calamus automatically uses Virtual 
Memory, so merging documents should not be a problem. The only limitation is the space 
available on your hard drive. 

An index requires several pages. To create index pages quickly, follow these steps: add one 
page to the end of your document and draw a full size index frame; click the icons for Piping 
from Previous Page and Piping to Next Page in the Text Special Functions command group; 
go to the Page module and click the Insert Empty Pages icon; enter 10 for the number of 
pages to be added After the current page and select Copy Layout; copy the layout from the 
page on which you created the index frame; click OK and 10 pages with piped index frames 
will be created.

Select the text frame at the beginning of the document and click the Piping from Frame to 
Frame icon. Then click the first frame in the index frame piping chain. You have now created 
a link between the index frame and the text frame. From this point, the Index Entry function 
works like the endnote example described under Footnote Entry in the previous section. Now
that the text frame and index frame are linked, you may begin creating index entries. Begin 
on page one and use the text cursor to mark words or phrases to be used in the index. After 
each marking, click the Index Entry icon. (If you do not mark a text block, an alert will 
appear.) The marked text will be copied to the index frame and will be visible after you use 
the Reformat Document function in the Options menu. 

If you want to attach a page number to an index entry, you must do so in the text editor 
window. Open the window and locate the index control code. Doubleclick the control code 
and the index editor window will open. It has the same menus as the regular text editor. Go 
to the Insert menu and click Insert Code. When the Insert Format Code dialog box appears, 
click the Insert Current Page Number icon. The page number control code will appear in the 
footnote editor window as [Page #] or [p]. Cursor past the control code and press the [Enter]
key at the end of the line. When the index information is reformatted in the index frame, 
each entry will appear on its own line. Close the index editor and proceed to the next index 
control code. Repeat the procedure. 

You copy or paste each index entry into an index frame. Copy will make a copy of the index 
entry; paste will move the index entry to the index frame. 

The final stage of index preparation involves the calculation of page numbers in the index 
frame. Click Reformat Document in the Options menu. This dialog box appears:



Index entries may be sorted in Alphabetical or Chronological order. You may also choose to 
Delete Old entries in the index frame or Add New information to it. Normally you would 
choose Delete Old. 

Set the page range in the Reformat Page input fields at the bottom of the dialog box and 
click OK to flow all index entries into the index frame. 

Be careful not to include the pages which hold the index frames in the page range to be 
reformatted. If you do, the page number for each index entry will be the same number as 
the page on which the index frame is located.



Insert Manual Kerning 

This function allows you to set kerning (letter spacing). Kerning can be done in four 
directions: up, down, left and right. When you click the icon, a dialog box    lets you enter 
values for both horizontal and vertical kerning. 

You can also insert kerning by positioning the text cursor, and pressing the [Esc] key. The I-
beam cursor will change to an L shape - this is the kerning cursor. Use [Shift] and any of the 
cursor keys to finekern text in the corresponding direction. Use [Control] and the arrow keys 
for coarser kerning.



Insert Comment 

Click this icon and a dialog box will appear in which you may enter a nonprinting comment 
or remark. This feature is handy for keeping private notes. It can also be used for creating 
project outlines on the fly. After entering a comment, click OK. Nothing will be visible in the 
text frame, but the Comment control code will be visible in the text editor. This function is 
used in conjunction with the Find Comment function described later in this chapter. 



Insert Text Style 

This function will insert a control code that affects the style of ensuing text. When you click 
this icon, the following alert will appear, but only if the List option is selected in the Text 
Style List Parameters. If you select the New button, the Edit Text Style dialog box will appear,
allowing you to select or define a text style for the currently selected text or text frame. The 
text styles offered match those in the Text Style list. Select the name of the text style you 
wish to use and then click OK. If you select Internal, the marked text will be restyled using 
current settings. 



Force Piping to Next Frame 

When this control code is entered, Calamus will consider the frame to be full at the cursor 
position and will pipe remaining text to the next frame in the piping chain. This function lets 
you limit the amount of text you wish to have in any frame.



Delete Text Block/Ruler 

This function will delete a marked text block or the selected text ruler. To delete text, mark 
text and click the trashcan icon (or use the [Delete] key). To delete a text ruler, click the text
ruler to select it; then click the trashcan icon. A text ruler remains in effect until another text
ruler is encountered in the frame or piping chain.

You cannot delete the first text ruler in a piping chain or a single, unpiped text frame. 



Tools Command Group 
Functions: 
Text Editor 
Drop Cap
Key Bindings Editor 
Find Comment  
Anchor Frame 
Copy and Anchor Frame 
Frame Anchor Settings 
Place Anchored Frame on Page 
Copy and Place Anchored Frame on Page 
Delete Text Block Ruler in Tools Command Group



Text Editor 

Calamus is equipped with a text editor for working quickly with large tracts of text. This 
method of editing is preferable to working in the text frame which takes time to refresh 
changes. To access the text editor, select a text frame and click the Text Editor icon. The text
editor is described in its own section of this chapter. 



Drop Cap

Mark the first letter or word of a paragraph and click the Drop Cap icon. Select Absolute or 
Relative Size and set the offset distance in the Drop Cap Parameters dialog box. A flush left 
margin will format text at the right side of the drop cap letter(s).



Key Bindings Editor

When you edit text, you can use certain    special keys to insert characters not present in 
your computer's regular character set. For example, while the ASCII character set has one 
dash, Calamus has three of varying length. The Key Bindings editor lets you decide which 
key binding will call up a particular character.

The following letters represent these special keys:

A = Alternate,
C = Control,
LS = Left Shift,
RS = Right Shift,
HOM = Home,
INS = Insert,
ENT = Enter,
SPC = Spacebar

Click the Key Bindings Editor icon. You will see the this dialog box with the current key 
bindings: 



The 21 key bindings are described below. You can change key bindings at any time. This 
procedure is described later in this section.

Key Bindings Editor Explained 



Key Bindings Editor Explained
Hyphenation Visible
Hyphenation Invisible 
Hyphen
En Dash
Em Dash
Hard Space
Variable Hard Spaces
End of Line - Normal
End of Line - Paragraph
End of Line - Variable Paragraph
Quotation Marks
ASCII Input
Refresh Page
Enable Text Macro
Text Input Delay 



Define Key Binding
To change any key binding in the Key Bindings Editor dialog box, click to the right of the 
binding name. A dialog box will appear. Click and enter the new keys you wish to use for the 
respective function. 

You may combine key bindings in any way. If a selected key binding is already in use, you 
will be asked to overwrite or replace the key binding.

The [Backspace], [Insert], [Home], [Enter], [Delete] and [cursor] keys do not produce a 
character on screen or on output. To use one of these keys, click its button in the dialog box.



Find Comment 

This function is used in conjunction with Insert Comment described earlier in this chapter. 
When you click this icon, a dialog box appears in which you should enter a specific word or 
phrase that has been included in a previously inserted comment. Choose the Search 
Direction and click the Search button. The cursor will move to the point where the text string
exists, provided you have searched in the right direction. 



Anchor Frame

This function anchors a selected frame or group frame to the current cursor position by 
converting it to an invisible control code. Anchor Frame is useful for making sure that 
graphics and other frames are kept in the same position relative to specific text. 

An anchored frame is assigned a position within the text at the cursor position. An Anchor 
Frame Data control code [afd] is inserted at the cursor position. The control code is visible in 
the text editor; it    contains data about the position and size of the anchored frame. 

It is possible to position an anchored frame so that its top or bottom edge matches, 
respectively, the ascent or baseline of adjoining text. Doubleclick the control code from 
inside the text editor to gain access to the Edit Anchor Frame dialog box.

An anchored frame is treated like any other text character of the same size: it can be 
deleted or placed on the clipboard; it can be tabbed along a text ruler; it is subject to the 
justification of the active text ruler. However, text attributes (italic, bold, underline, etc.) 
cannot be applied to an anchored frame. Text flow around an anchored frame is subject to 
the line spacing of any text character of similar size. This means that the bottom edge of an 
anchored frame is like the descender of a letter. As such, text on the next line will appear 
below the bottom edge of the anchored frame.

Any number of frames on a page may be anchored to text. Anchored frames exist only 
within the text and cannot be edited in their original form unless pasted back on the page. 
To anchor a frame, follow these steps: 

- Place the text cursor at the desired position. 
- Click the Anchor Frame icon. 
- Click the frame to be anchored. 
- Click the Anchor Frame icon a second time 



Copy and Anchor Frame 

This function will anchor a copy of a selected frame and leave the original frame on the 
page. This allows you to anchor the original frame to another position. To copy and anchor a 
frame, follow these steps:

- Place the text cursor at the desired position. 
- Click the Copy and Anchor Frame icon. 
- Click the frame to be anchored. 
- Click the Copy and Anchor Frame icon again.



Frame Anchor Settings 

This function allows you to position the anchored frame so that its top edge matches the 
ascender line of the text, or its bottom edge matches the baseline of the text. The first 
choice will cause the anchored frame to hang from a line of text. The second choice will 
make the anchored frame sit on the text baseline. 

You can also edit the dimensions of an anchored frame character. To do so, mark the 
anchored frame character using the Ibeam text cursor. Then click the Frame Anchor Settings
icon. In the dialog box that appears, enter the desired settings for the anchored frame. 



Place Anchored Frame on Page 

This function removes an anchored frame from its position in the text frame and places it 
back on the page in its original location. This feature can also be used to place the anchored 
frame in another location. 

Use the Ibeam text cursor to mark the anchored frame character as you would mark a text 
block. Click the Place Anchored Frame on Page icon. 

The anchored frame will be placed at its original position on the page. The anchored frame 
character will be removed from its current position and the control code will be erased. 



Copy and Place Anchored Frame on Page 

This function works the same as Place Anchored Frame on Page, except that the anchored 
frame character remains in the text frame. This function is used when you want to anchor 
the same frame to more than one position. By creating a copy of the original frame, you may
anchor it in the normal manner. 

Use the Ibeam text cursor to mark the anchored frame character as you would mark a text 
block. Click the Copy and Place Anchored Frame on Page icon. 

A copy of the original anchored frame is placed on the page in its original position. The 
anchored frame character is left intact in the text frame. 



Delete Text Block/Ruler in Tools Command Group

This function, in this location, is used to delete an anchored frame character from the text 
frame. Simply mark the anchored frame character as you would mark a text block, and then 
click the icon. 



Dictionary Command Group 
Functions:

 Spellchecker
 Edit Spellcheck Dictionary
 Save Spellcheck Dictionary 
 Load Spellcheck Dictionary 
 Hyphenate Text 
 Hyphenation Settings
 Edit Hyphenation Table
 Save Hyphenation Table 
 Load Hyphenation Table 

 This command group is composed of two sets of similar icons. These icons access the 
various functions associated with spellchecking and hyphenation. Dictionary files have a 
CWB extension. Hyphenation tables are contained in a file with a CHP extension. Various 
language dictionaries are available, contact DMC for information. 



Spellchecker 

This command searches text for words that do not match those in the loaded dictionary file. 
When a mismatch is located, this dialog box will appear; you may edit the spelling of the 
indicated word, or add it to the dictionary. 

Calamus uses an algorithm to find letter combinations which are not likely to be correct. As a
result, it can ignore such typographical errors as mispelling (for misspelling), where both 
could be correct.



Edit Spellcheck Dictionary 

After you have loaded a spellcheck dictionary, you can edit its contents. Click this icon and a
dialog box containing four functions will appear. These functions are similar to those in the 
Edit Hyphenation Table, discussed later in this chapter.



Add Word to Spellcheck Dictionary 
You may add words to a spellcheck dictionary. Enter a word on the edit line and click this 
button. The word will now appear in the list.

Remember to save the dictionary after you have added words. 



Delete Word from Spellcheck Dictionary 
This function allows you to delete any word from the current dictionary. Click the word in the 
list. It will also appear in the edit field. Now, click the Delete Word button and the word will 
disappear from the list. Save the dictionary after you have deleted words if you wish to 
customize it for later use. 



Look Up Word in Spellcheck Dictionary 
To find a word in the current dictionary, enter it in the edit line and press [Enter]. If you are 
unsure of a spelling, enter part of the word and Calamus will locate the first occasion of the 
text string. 



Delete Spellcheck Dictionary 
This function will erase the current spellcheck dictionary from memory. If you wish to save 
changes to the current dictionary, do so before using this function. 



Save Spellcheck Dictionary 

This command allows you to save the current spellcheck dictionary. With this function, you 
can create new dictionaries for specific purposes (scientific, technical, medical, etc.). Any 
changes made to the dictionary will not be permanent until you use this function. The file 
selector will appear and allow you to choose a name for the dictionary. Use a CWB extension.



Load Spellcheck Dictionary 

This command allows you to load a spellcheck dictionary. Without a dictionary loaded, you 
cannot check for spelling errors. When you click the Load Spellcheck Dictionary icon, the file 
selector will appear. Simply choose the dictionary file you wish to load. 



Hyphenate Text 

This function allows you to hyphenate text if you have loaded a hyphenation table file. This 
feature is accessed when you have not selected automatic hyphenation. A text frame or text
block must be active. If you have selected a text frame, Calamus will ask whether you want 
to hyphenate all frames in the piping chain. 



Hyphenation Settings

When you select this function, a dialog box will appear. You can have Calamus automatically 
hyphenate text as it is imported. Otherwise, you would manually hyphenate text using the 
Hyphenate Text function, previous. See also Set Hyphenation Parameters in the Text Ruler 
Command Group later in this chapter. 



Edit Hyphenation Table 

After you have loaded a hyphenation table, you may edit its hyphenation rules by clicking 
this icon. This dialog box will appear: 

The hyphenation table includes the OK button, an edit field and five command buttons. 
When you enter a word in the edit field and press [Enter], the word will be hyphenated 
according to a set of algorithms. There are words in the English language which cannot be 
hyphenated correctly by using rules. For example, in the word software, the final e is silent 
and there are two syllables: software. On the other hand, in the word catastrophe, the final e
is pronounced, providing an extra syllable: catastrophe. The hyphenation table is designed 
to catch such cases. 

Add Word to Hyphenation Table 
Delete Word from Hyphenation Table 
Look Up Word in Hyphenation Table 
Delete Hyphenation Table 
Uncertain Hyphenation 



Save Hyphenation Table 

Use this function to save a hyphenation table. This feature allows you to define hyphenation 
for specific tables. The file selector will appear and allow you to enter a name for the 
hyphenation table. 



Load Hyphenation Table 

This command allows you to load a hyphenation table. If a hyphenation table is not loaded, 
you cannot hyphenate text. The ENGLISH.CHP file contains the hyphenation tables.



Character Set Command Group 

The character table shows part of the currently selected font. The characters shown here are
in the currently selected font. Since there is room for only 12 characters in the display area, 
use the vertical scroll bar or arrow buttons to move through the list. If you click the mouse 
on one of the characters, it will appear at the cursor position in the text frame, as if you had 
entered it from the keyboard. This feature is often used to input an accented character not 
available from the keyboard.



Text Ruler Command Group 
 Functions:
 Insert Tab 
 Insert Leader Tab 
 Delete Tab 
 Absolute Line Spacing 
 Left  Justified Text   
 Centered Text 
 Relative Line Spacing 
 Right  Justified Text   
 Fully  Justified Text   
 Line Spacing 
 Paragraph Spacing 
 Justified Word Spacing
 Set Leader Tab Character 
 Set Hyphenation Parameters 
 Vertical Text Alignment 
 Insert Text Ruler 
 Edit Text Ruler
 Delete Text Block/Ruler in Text Ruler Command Group  

Text rulers allow you to format paragraphs within text frames. Formatting includes text 
justification (centered, left, right, or fully), paragraph spacing and line spacing. Other 
elements such as tabs, left and right margins, and paragraph indentation are also included 
in a text ruler. 

You may use as many text rulers as you want. A text ruler stays in effect until the next text 
ruler is encountered. To edit a text ruler, click the right mouse button to switch from Text 
mode to Ruler mode; the Ibeam will change to a cross hair cursor: 

You cannot move the tab, margin or paragraph icons if Insert Tab, Leader Tab or 
Delete Tab has been selected.

First, make sure that the icons for Insert Tab, Insert Leader Tab, and Delete Tab are 



deselected. Click the right mouse button inside a text frame to show its text ruler(s). The I-
beam cursor changes to a cross hair. Click the text ruler in which you want to move a tab, 
margin or indent icon. Click the cross hair on a text ruler which will then appear with a dark 
upper border, showing that it is active. You can now move (click and drag) the indent, 
margin and tab.

To move an icon within a text ruler, place the cross hair on the icon and keep the left mouse 
button pressed as you drag the icon to the desired position. To apply the new ruler settings, 
click the right mouse button. You can also press [Shift] and click a text ruler to call the Ruler 
Settings dialog box for precise placement.



Insert Tab 

When you select this icon, you can use mouse clicks to insert tabs in the current (active) text
ruler. Tabs allow you to align text in columns. You are probably familiar with tabs on a word 
processor. The tabs in Calamus are more powerful, since they simultaneously serve as left-
justified, rightjustified, centered or decimal tabs. To tab text, press the [Tab] key. Usually, 
everything from the last space will be indented so that text is directly under the tab in the 
text ruler.

If you press the [Tab] key before and after a word, the word will be centered under the tab.

By using fixed hard spaces, the text is locked together as one long word which is then 
centered on the tab. 

Effective use of tabs takes practice. Fortunately, Calamus' tabs are more flexible than any 
other kind. 



Insert Leader Tab 

A leader tab is different from a normal tab. The space created by pressing the [Tab] key is 
filled with a keyboard character selected by the user. You can, for example, use this function 
to put dots between a chapter name and its page number in a table of contents. Use the Set 
Leader Tab Character function, below, to select character(s) for your leader tab. 



Delete Tab 

The eraser icon allows you to remove tabs from the current text ruler. Click the icon and 
then click the tab(s) you wish to delete. 



Text Justification 

These four icons control the justification of text within a frame. Leftjustification (the selected 
icon) is how we normally enter text and, as such, is the default; all lines begin on the left 
side, but the right side is ragged. Rightjustification is the opposite; all lines are flush on the 
right, but the left side is ragged. When text is centered, each line has the same amount of 
space on the left side and on the right side; in other words, both sides are ragged. In fully-
justified text, Calamus inserts enough space into each line so that both the left and right 
sides are flush with the frame's left and right edges, or with left and right margin flags.

To change formatting in a section of text, select the text ruler immediately before it and then
click the desired justification icon. Click the right mouse button to reformat. 

If you want to change the justification of a section of text which does not have a separate 
text ruler, switch to Text mode and mark the section as a block; next, click a justification icon
and then click the Insert Text Ruler icon. Calamus will insert a new text ruler immediately 
before the block, and a copy of the existing text ruler at the end of the selected block. 



Absolute Line Spacing/Relative Line Spacing 

These icons apply only to the currentlyselected text ruler. They determine how the space 
between two lines will be measured. Absolute line spacing is the distance between two 
identical points on two identical characters on neighboring baselines. Relative line spacing is
the white space between the bottom of one line and the top of the next. The various 
character dimensions are based on the type of character height chosen in the Text Style 
module (Em, Versal or Designer).



Line Spacing 
You may set the line spacing for a text ruler in fixed or relative terms. Fixed units of measure
are selected in Set Units of Measure, in the Page module. Relative measurement is 
expressed as a percentage of the current character height. The latter method maintains a 
consistent ratio between font size and line spacing; however, in most situations, a fixed 
system is preferable.

To set line spacing, simply click the input field and enter a value. To change between fixed 
and relative, click the unit of measure or %. The value in points or millimetres will be 
converted to percentage and vice versa. For the percentage value, the font height set in the 
Text Style module will be used (Em, Versal, or Designer). Line spacing applies to text whose 
lines are not separated by a carriage return; that is, created by pressing the [Enter] key. 



Paragraph Spacing 
Paragraph Spacing is similar to Line Spacing. A paragraph ends when a carriage return is 
created by pressing the [Enter] key. To change between fixed and percentage spacing, or to 
set spacing values, see Line Spacing, previous.



Justified Word Spacing 

This command allows you to set the minimum and maximum space between two words in 
fullyjustified text, as indicated in the dialog box. Minimum and maximum spaces are 
registered as a percentage of the Em width (based on the letter M). If Calamus cannot apply 
these values when formatting text, an alert will appear and formatting may be aborted. You 
can then change the text in the problem area (for example, insert hyphenation) and try 
again. 



Set Leader Tab Character 

This command allows you to select the character which Calamus will use to fill a leader tab. 
Enter a character from the keyboard. For nonkeyboard characters, use the Windows 
Character Map.

The edit field allows you to enter not only a single character, but a character sequence 
which will fill the space created by a leader tab. A single character will be repeated to the 
leader tab.

As with all text ruler elements, the established fill character applies only to the selected text 
ruler. If no text ruler is selected, the fill character will apply to the next ruler created. 



Set Hyphenation Parameters 

First you will see the CK to KK Hyphenation On/Off option. This is a hyphenation option for 
specific German characters. The next item lets you establish the Minimum number of 
characters before and after a hyphen when text is hyphenated automatically. In the field, 
Maximum number of hyphenated words in a row, you can set the number of consecutive 
lines which can end in a hyphen. It is generally accepted that two hyphens in a row are 
enough. Once the limit is reached, Calamus will not hyphenate the next few lines. 
Conversely, you can set Minimum number of lines between hyphenations. Press [Enter] or 
click OK to close the dialog box. 



Vertical Text Alignment 

This function affects the vertical arrangement of lines of text within a frame. It corresponds 
to the left, right, centered and fullyjustified options which affect the alignment of characters 
within a line. Settings here can apply not only to the current text ruler, but to the entire 
frame or piping chain. 

You may also determine whether the frame should be filled with text from top to bottom, 
that is vertically justified. Calamus will enlarge the space between paragraphs to ensure that
text fills the frame. You can also decide whether Calamus should insert just the space 
needed, or entire lines. 

Calamus can apply this function to selected paragraphs or to an entire frame. To select 
certain paragraphs, use the key binding defined for Variable Paragraph in the Key Bindings 
Editor described earlier in this chapter. Finally, you can decide whether to apply these 
settings only to the current frame or to every frame in the text chain. 



Insert Text Ruler 

You may insert a text ruler anywhere you want within a text frame. There are three 
possibilities: 

- With no text block marked, and the cursor at the beginning of a line, the text ruler will be 
inserted before the current line.

- With no text block marked, and the cursor within or at the end of a line, the new text ruler 
will be inserted at the end of the current line; the current line will not be affected by the 
settings of the new text ruler. 

- With a text block marked, two text rulers will be inserted: a new one at the beginning of the
block and a copy of the existing one at the end. 



Edit Text Ruler
At the beginning of the Text Ruler command group, there were instructions for moving 
margin and tab icons by using a click and drag method with the cross hair cursor in Ruler 
mode. While this method gives you a realtime view of how tabs and margins affect text 
formatting, it is not precise, even when used with the Coordinate Display.

To precisely edit the settings of any text ruler, press [Shift] and click the cross hair cursor on 
the ruler. The following dialog box will appear for you to define the ruler's settings:

The input fields can be used to change line spacing, paragraph spacing, margins, indents 
and the leader tab character. You can also choose text justification and absolute or relative 
line spacing. On the right side is the input window for tabs. Click Add or Edit and this dialog 
box will appear to enter tab settings and type.

At the bottom are two buttons: one for setting hyphenation parameters and the other 
(Block) for defining the minimum and maximum width of a space used to justify text. These 
functions are described earlier in this chapter in the Text Ruler command group. When you 



access either of these buttons, the appropriate dialog box will appear.



Delete Text Block/Ruler in Text Ruler Command Group 

This function is used to delete a text block or text ruler from a text frame. Simply mark a 
text block or activate a text ruler, and then click the icon. This function does not have an 
Undo command.



Text Macro Command Group
Functions:

 Start Block 
 End Block 
 Load Macro File 
 Define Macro 
 Change Macro 
 Save Macro List 

Text macros, usually called macros, make it possible to assign text strings, text rulers and 
text styles, or any combination of these, to key bindings defined by the user. Some of the 
possibilities are described below. 

The simplest use of macros is as glossary keys to generate not just individual letters, but 
entire words, sentences or even complete chapters. An example of a text macro is the word 
Sincerely followed by blank lines, space, and the writer's printed name at the end of a letter. 
When creating a macro, you can mix text with text style and layout codes.

If you use tables in a document, you may want to save the appropriate text ruler as a macro,
ensuring tabs will be identical from table to table. 

There are two ways to apply a macro. The first method is to click the name of the macro in 
the macro list. This method is described later in this section. The second method is to use 
the key binding assigned to the macro. Every macro has a key binding to call up its contents.
When using the second method, it is necessary to enable the text macro by using the key 
binding defined in the Key Bindings Editor described in the Tools command group earlier in 
this chapter. For example, if [Control]+M is the key binding to Enable the Text Macro, and 
[Control]+D is the key binding to insert the current date, you would press [Control]+M, then 
[Control]+D, to call your date macro and insert the date.

Macros allow you to use text styles as defined in the Text Style module. With a macro, you 
can select a text style from the keyboard instead of clicking your way through icons to get to
the text style list. 



Depending on the macro's content and whether you have selected a text block, Calamus will
carry out certain actions: 

- If the macro contains text and no text block is marked, the macro's text will be inserted at 
the cursor. 

- If a text block is marked, the block will be deleted, and the macro's text inserted in its 
place. 

- If the macro contains a text ruler and no text block is marked, the macro's text ruler will be 
inserted at the cursor.

- If a text block is marked, two text rulers will be inserted: the macro's text ruler before the 
block and a copy of the previous (existing) ruler after the block. 

- If the macro's contain text style information and no text block is marked, the text style 
information saved in the macro will be inserted at the cursor.

- If a text block is marked, two text style control codes will be inserted: the macro's style 
before the block, and a copy of the previous (existing) style after the block. 

The macro list will display up to 24 macro names. To view additional macro names, click the 
vertical scroll bar.



Start Block/End Block

The Start Block and End Block functions are used to mark a block of text. Place the Ibeam 
cursor at the point where you want to begin a text block and click the Start Block icon; all 
text after the cursor will become inversed. Press the [Shift] and click where you want to end 
the text block, then click the End Block icon. Only the text between the start and end points 
will remain inversed.

See the beginning of the Text Module section for information about marking text by using 
the keyboard or mouse clicks.



Load Macro File 

When you click this icon, the file selector appears and lets you load a set of macros 
previously saved. If macros are already installed, they will be replaced. 



Define Macro 

This command allows you to save selected text, text style and/or text ruler information as a 
macro. If no text block is marked, Calamus will ask if you want to use the entire piping chain.
This dialog box will appear: 

In the top section, you enter the key binding which calls up the macro. 

There are four special keys which you may use with other keys to call up macros. These keys
are [Control], [Alternate], left [Shift] and right [Shift]. Calamus distinguishes the two [Shift] 
keys here. For numbers and mathematical signs, you may choose the Numeric Keypad or 
leave it unselected in order to use numeric characters above the letter keys.

In the middle section, you may select a hot key to be used with the special key. You should 
just type the key itself if it produces a character that prints on screen. If it does not, click the
key in the dialog box.

Theoretically, the 90 keyboard keys and the 16 special key combinations [Control], 
[Alternate], left [Shift] and right [Shift] present a potential of 1440 macros. However, some 
of these macros are already used for program key bindings and are not available. 



In the bottom section of the dialog box, you must enter a name for the macro being created.
The Use Style, Use Ruler, and Use Text options allow you to specify the information to save 
in the macro. Click any button to select an element. 

When you click OK or press [Enter], the dialog box will disappear and the name of the new 
macro will appear in the macro list. If you have already used the key binding or the macro 
name, an alert will prompt you to enter a different binding or macro name. 



Change Macro 

You may change a macro in one of four ways: 

To change the key binding used to call a macro, click the Change Macro icon, then click the 
name of the macro. When the dialog box appears, simply click new keys for the key binding.

To delete a macro, click the Change Macro icon, then click the name of the macro to be 
deleted from the list. When the dialog box appears, click the Delete button. 

To rename a macro, click the Change Macro icon, then click the name of the macro you want
to change. When the dialog box appears, change the macro name in the Macro name edit 
field.

 To change the contents of a macro, mark a text block first. Click the Change Macro icon, 
then click the macro name. Click the New button. The Use Style, Use Ruler and Use Text 
buttons will become selectable. Click the elements you wish to save in the macro and click 
OK.

If you have not marked text, you may change the elements in a macro. Click the Change 
Macro icon, then click the macro name. Click the Edit button. The Use Style, Use Ruler and 



Use Text buttons become selectable. Click the elements you wish to save in the macro and 
click OK.



Save Macro List 

Click the icon and enter a filename in the file selector to save the current macro list. Any 
macros used in a document are automatically saved with that document.



Hyphenation Visible
This control character, assigned by a key combination, is used to insert hyphenation. 
Wherever it appears, hyphenation may take place at the end of the line. Normally, this 
control character is not shown, but when a word must be split at the end of a line, a hyphen 
will appear. 



Hyphenation Invisible
This control code works like the Hyphenation Visible control code, previous, except that it 
will not appear as a visible hyphen. You can use this code to show where word combinations 
such as black/white should be divided at the end of a line. 



Hyphen
The hyphen is a dash used to join compound words, such as treehouse. 



En Dash
The en dash is a dash that has the same width as the uppercase letter 'N'. It is used to mark 
a range of numbers, such as in 1994-1997. 



Em Dash
The em dash is a dash as wide as the uppercase letter 'M'. It is used for a break in thought    
like this    in the middle of a sentence. 



Hard Space
A hard space cannot be shrunk or enlarged to justify a line of text. Hard spaces may also be 
used to lock two words together so that they cannot be separated by a lineend. Press either 
[Shift] key and the [Spacebar] to enter a fixed hard space.



Variable Hard Spaces
Variable hard spaces can be fixed at a specified width. The width of the variable hard space 
is defined in relation to the width of a capital letter 'M'.    There are five preset widths. You 
can also define Em spaces in any percentage of Em by doubleclicking the [vhs] control code 
in the Text Editor.



End of Line - Normal
This control code allows you to mark the end of a line of text. During reformatting, Calamus 
will break the line at this control code, but will not begin a new paragraph; regular line 
spacing will follow and there will be no indent on the next line; fully justified text will fill out 
the current line. In short, the code will insert a line end, not a paragraph end.



End of Line - Paragraph
This control code ends a paragraph. Paragraph spacing will follow and the next word will be 
indented according to text ruler settings. 



End of Line - Variable Paragraph
To vertically justify text, insert this code to automatically expand the spacing of paragraph 
ends. For more information, see Vertical Text Alignment later in this chapter. 



Quotation Marks
For proper typography, you should use different marks to begin and end a quotation. There 
are two kinds of opening quotation marks and two kinds of closing quotation marks. This 
function allows you to specify which keys will call up which type of quotation mark.

Here is an example of how to use the quotation marks: 

John says 'Goodbye'. 



ASCII Input
ASCII input is a method of entering a character by typing its ASCII code number. Hold down 
the [Alternate] key while you enter the ASCII number and the character will appear at the 
text cursor. The ASCII code of a character is shown in the Windows Character Map.

See Appendix I.



Refresh Page
This key binding allows you to refresh a page which you have already displayed. If you have 
aborted a page refresh by pressing [Control][Shift][Alternate], this function will refresh the 
page. 



Enable Text Macro
This key binding is used to activate the text macro functions described later in this chapter. 
Each time you want to use a text macro, you must use this key binding first.



Text Input Delay
You can set an interval for Calamus to wait after text entry before the screen is refreshed. A 
longer delay lets you enter more text before each refresh. Click the input field and enter the 
desired interval. If you type slowly, you may want to use a long delay.



Add Word to Hyphenation Table
To add a word to a hyphenation table, you must first provide the correct hyphenation. 
Calamus understands two types of hyphenation logic: syllable division and word division. In 
the table, syllables are divided by using '', while words are divided with '+'. For example, 
underwater would be hyphenated under+water. When you enter a word and press [Enter], 
Calamus will attempt to hyphenate the word automatically. In this case, it would guess un-
derwater, which is not entirely correct. If you click the mouse once on the hyphen between 
under and water, it will change to '+', marking a word break. If you click between two letters
where there is no `', a `' will appear. A second click on `' will produce `+'. Finally, clicking `+'
will eliminate the break altogether. Once you have hyphenated a word, click the Add Word 
button to enter it in the hyphenation table. The new word will be added permanently if you 
save the hyphenation table before exiting Calamus. 



Delete Word from Hyphenation Table
To delete a word from a hyphenation table, click the word and then the Delete button. 



Look Up Word in Hyphenation Table
This button has the same effect as pressing the [Enter] key. Calamus will look up the word 
you entered and show its hyphenation. 



Delete Hyphenation Table
When you click this button, an alert will appear; allowing you to remove the hyphenation 
table from memory. 



Uncertain Hyphenation
This function is unique to Calamus. Some words are hyphenated differently in different 
contexts. You can mark such words as uncertain in a hyphenation table so that Calamus will 
stop and ask you to supply hyphenation. To add such a word to a hyphenation table, enter it 
in the edit field, then click the Uncertain button. Words that have been defined as having 
uncertain hyphenation will appear with a question mark to the right of them. 

When Calamus attempts to hyphenate such a word, the Uncertain Hyphenation dialog box 
will appear, allowing you to define the hyphenation for the word. You may enter hyphenation
for a word with a mouse click as in the Hyphenation Table dialog box, above. 

 




